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Overview 
Mr. Paint is a simple ATASCII text screen editor.  It is designed 
to allow the creation of single screens (40 columns by 24 rows).  It 

is not designed for the creation of ATASCII movies.  In other 
words, it does not record or save cursor movements or other active 

screen manipulation keystrokes.  It is suitable for creating text 

screens with ATASCII or ASCII content. 

Mr. Paint was born out of frustration with existing offerings.  Mr. 

Paint was developed using the C language and compiled with CC65.  

The user interface highly utilizes my A8CLibrary (Atari 8 Bit C 

Library) TUI (Text User Interface) routines. 

Mr. Paint’s core features: 

•ATASCII Save 
•ATASCII saves utilize carriage returns at the end of each line, 
with or without trimmed lines, and with or without a preceding 

clear character. 

• Sized Save 
• Sized saves save the screen content up to the end of screen 
marker which can be set by the user, but otherwise follows the 

ATASCII save. 

• Raw Save 
• Raw saves save the entire screen without a clear character, 
carriage returns (newlines), or trimmed lines. 

• Disk Directory 
• The disk directory function provides a means to see the files on 
attached disks.  It has the ability to specify file masks to 

refine file searches. 

• Print Screen 
• Print allows the screen editor contents to be output to a printer 
that supports ATASCII printing. 

• Advanced User Interface 
• The user interface follows typical modern day interface standards 
making usage easy to understand.  Mr. Paint also goes to great 

lengths to prevent the accidental destruction of an edited screen 

through confirmation prompts where appropriate.  In addition, any 

time there a user entry field is presented, a small “Nav” bar will 
appear on the bottom of the window indicating which keys are 

active for that input control. 

• Simple Operation 
• Mr. Paint was designed without a lot of fluff, to do one thing, 
using modern interface elements, and minimal keystroke 

combinations to remember, making it easy to use. 
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Revisions 

Conventions Used in Manual 

-

Keys to be pressed are referenced with bold and all uppercase, 

such as RETURN. 

Date Version Description

2025.01.25 1.00 Initial release.

2025.02.07 1.03 -Fixed screen corruption when escaping file load. 

-Fixed keyclick disabled at exit. 

-Added XL/XE machine check at start.

2025.02.08 1.04 -Fixed keyclick status showing opposite on status 

and preferences dialog from that of actual 

setting.

2025.02.08 1.05 -Added row and column fill.

2025.02.09 1.06 -Restrict Control Shift character entry to prevent 

invalid character entry.

2025.02.09 1.07 -Added ability to draw special characters for 

ATASCII art images: up, down, left, right, clear, 

tab, delete, and escape. 

-Remapped some key combinations to accommodate 

special character drawing such that keys make 

sense.

2025.02.10 1.08 -Added center row. 

-Optimized build for smaller executable.

2025.02.11 1.09 -Increased soft click duration slightly. 

-Restored Ctrl-H. 

-Set cursor default home to center of screen. 

-Set Control-Shift-H to home cursor (center). 

-Added Control-Shift-0 to zero cursor (0,0). 

-Fills (background, row, column) now pre-populate 

input with value of character under cursor.
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System Requirements 
-

Atari XL or XE computer with at least 64K of memory.   Additional 

memory beyond 64K will not be utilized. 

-

Disk drive.  At least one is needed.  The number of drives 

supported depends on the DOS. 

-

Drive density support depends on the DOS. 

-

Optional ATASCII printer.  An ATASCII printer is defined as 
being one that can natively print ATASCII characters such as the 
emulated ATASCII printers in Atari800MacX and FujiNet. 

DOS Compatibility 

Mr. Paint has been tested with a large number of DOS’s.  
Compatibility notes can be found in the table below: 

DOS Version Compatible Notes

Atari DOS 1.0 No

Atari DOS 2.0s Yes

Atari DOS 2.0d Yes

Atari DOS 2.5 Yes

Atari DOS 4.0 Yes

Happy DOS II+/D Yes

MyDOS 4.53 Yes

OSS DOSXL 2.20 Yes Crash on exit when executed from 

Menu shell.

OSS DOSXL 2.30p Yes Crash on exit when executed from 

Menu shell.

SmartDOS 6.1d Yes Crash on exit regardless of 

ResiDUP setting.

SpartaDOS 3.2g Yes

SpartaDOS X 4.49 Yes Requires 128K+ RAM.

SuperDOS 2.0 Yes

XDOS 2.51 Yes
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Running Mr. Paint 

Installation 

Mr. Paint is installed by copying the executable file to a bootable 

DOS diskette.  No additional files are necessary. 

You can optionally copy the sample save files (*.ATA) if desired. 

Non XL/XE Hardware 

Mr. Paint will check to see if XL/XE hardware is present at start.  

If not found, the splash screen will display a message indicating 

the failed requirement, and cause an exit once the splash screen is 

dismissed. 
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Launch 

Command Line DOS 

To start Mr. Paint from a command line DOS, enter the name of the 

executable and press ENTER.  If the program is on a different disk 

than the currently selected one, ensure the disk number is 

specified.  For example “D2:MRPAINT.XEX”.   

Note: In the case of SpartaDOS, it is best to use the “X” option 
such as “X MRPAINT.XEX”. 

Shell Based DOS 

To start Mr. Paint from a shell based DOS, use the shells binary 

load function.  Many times this is “L”, but consult the DOS shell 
menu and/or manual to be sure.  Then enter the drive specification, 

name, and press ENTER. 
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Things You Should Know 

Mr. Paint tries not to interfere with your workflow.  To that 

extent, after a splash screen at launch you are left in an empty 

editor screen.  The splash screen gives you just enough instruction 

to get you started.  

At an absolute minimum you need to know that pressing the START 

button invokes the main menu.  Additionally helpful, pressing the 

HELP button will bring up a help screen describing the available key 

combinations and their function.  This is also available from the 

main menu. 

The splash screen also contains the program version and build date.  

Should you find yourself with multiple copies, this is an easy way 

to discern which is which. 

The editor itself is a blank screen with a flashing cursor in the 

middle of the screen, which is considered the home position: 

6



Editor 
The editor is very simple.  Most keystrokes will be familiar to the 

Atari user, with only a few exceptions.  The editor works very much 

like the Atari Memo Pad, but with a flashing cursor.  Simply move 

around the screen with the arrow keys, and type the character you 

want displayed. 

The editor features the ability to turn cursor auto advancement on 

and off.  With auto advance turned on, the cursor will always move 1 

character to the right after a character key press.  With auto 

advance turned off, the cursor will remain in place after a 

character keypress.  In the off mode, it allows you to quickly 

experiment with different characters when drawing complex ATASCII 
screens, without having to constantly move back.  This can be 

toggled in the Preferences dialog. 

The editor also features a simulated key click noise.  The click is 

very subtle but meant to provide some audible feedback if desired. 

Mr. Paint will set itself to match the current system setting when 

launched.  This can be toggled in the Preferences dialog. 

Keystroke Notes 

While Mr. Paint was designed to NOT include characters that impact 

cursor movement when displayed, such as those used in the creation 

of ATASCII movies, provisions have been made to enter these 
special characters into a screen.  This can be useful for the 

creation of ATASCII art screens, where the special characters are 
displayed, but not acted on. 

The special characters should not be used when creating RAW format 

screens.  You can, but it is not the intended function, and 

displaying them back may not be accurate depending on how you invoke 

the display of the saved RAW file. 

The same can be said for the normal saved files.  Including them may 

not produce the intended result depending on how the saved file is 

displayed.  The special characters do NOT have ESCape characters 

before them in the saved file. 

Essentially, if you use them, your on your own.  You are squarely 

outside the intended scope of Mr. Paint.  Know exactly what you are 

doing.  For example don’t add a clear character if your saving the 
file with a clear character pre-pended, and then expect to not have 

the screen cleared after the first pre-trended one.   

If the display of the saved file is not what you expect, it is not 

the programs fault.   
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Keystrokes 

Pressing HELP or using the main menu’s Help/Keys option will display 
key combinations and their functions in a brief form.   

Available keystroke combinations and their functions are detailed in 

the table below: 

Keystroke Description

Help Displays the Keys help screen (as depicted above).

Start Opens the main menu.

Option Displays a popup dialog showing the status of 

preferences, filename, and cursor location.

← Move cursor left 1 character.  Cursor will wrap 

from left border to right.

→ Move cursor right 1 character.  Cursor will wrap 

from right border to left.

↑ Move cursor up 1 character.  Cursor will wrap from 

top border to bottom.

↓ Move cursor down 1 character.  Cursor will wrap 

from bottom border to top.

Return Moves cursor to the next line and far left column.

Shift-Control-0 Homes the cursor to the upper left corner of the 

screen (0,0).

Shift-Control-H Centers the cursor on the screen.

Tab Moves the cursor 10 characters to the right.

Shift-Tab Moves the cursor 10 characters to the left.
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Control-Tab

Draws the Tab character (►).  For use in ATASCII 
art screens.

Insert Inserts character at cursor position and shifts 

remainder of the line 1 character to the right.  

Characters pushed off the right side are lost.

Shift-Insert Inserts a line at the cursor position.  All lines 

below are shift down by one line.  Lines pushed off 

the bottom are lost.

Delete Deletes the character under the cursor.  If Auto 

Advance is turned on, it also moves the cursor 1 

character to the left.

Shift-Delete Deletes the line at the cursor position.  All lines 

below are shifted up by 1 line.

Control-Delete

Draws the Delete character (◄).  For use in ATASCII 
art screens.

Control-W Wipes (clears) characters from the cursor position 

to the start of the line.

Shift-Control-W Wipes (clears) characters from the cursor position 

to the end of the line.

Shift-Control-D Deletes (clears) all characters on cursors current 

row.

Clear (}) Draws the clear character (}).  For use in ATASCII 
art screens.

Shift-Control-Clear 

(})
Draws the left arrow character (←).  For use in 
ATASCII art screens.

Shift-Control-Insert

Draws the right arrow character (→).  For use in 
ATASCII art screens.

Shift-Control-↑ Draws the up arrow character (↑).  For use in 
ATASCII art screens.

Shift-Control-↓ Draws the down arrow character (↓).  For use in 
ATASCII art screens.

Shift-Control-E Toggle the end of screen marker (end line).

Shift-Control-M Show the keyboard control character map.

Escape

Caps Toggle CAPS lock.

Inverse Toggle Inverse characters.

All others Draws the given character at the cursors position.  

If Auto Advance is turned on the cursor will be 

moved 1 character to the right.

Keystroke Description

Draws the escape character ( ).
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Control Key Map 

A map showing the control key to keystroke mapping can be invoked 

from the editor or from the main menu.  It is meant as a quick 

reference for finding ATASCII characters, both inverse and normal. 

To invoke it from the editor, press Control-Shift-M. 

Status Display 

A dialog showing the status of program preferences, screen 

modification state, cursor location, end line marker location, and 

filename can be displayed at any time by pressing the OPTION button. 
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End Line (Screen) Marker 

Mr. Paint allows saving partial screens, from the top row to a 

specified row.  The End Line (or Screen) marker sets the last line 

to be saved.  To set the End Line marker, press Control-Shift-E.  To 

clear the marker, press the key combination again. 
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Menu 

Main Menu 

The main menu contains four options.  This menu and the option menus 

operate in the same manner.  Keys accepted are: 

- LEFT and RIGHT, or UP and DOWN, will move between selectable 

options. 

- RETURN selects the currently highlighted item. 

- ESC exits the menu. 
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File Menu 

The File menu contains options related to file handling. 

Keys accepted are: 

- LEFT and RIGHT, or UP and DOWN, will move between selectable 

options. 

- RETURN selects the currently highlighted item. 

- ESC exits the File menu. 

The descriptions and usage of each option are detailed on the 

following pages. 
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Directory 

Invoking the directory option opens a full screen directory viewer.  

The top portion has selectors for the drive and file mask.  The 

lower section will show up to 60 files matching the file mask on the 

selected drive. 

Press D to change the drive number.  Use the LEFT, RIGHT, UP and 

DOWN keys to change the drive number.  Use RETURN to accept the 

entry.  If a disconnected drive is selected, and error indicating 

the drive can not be opened will be displayed. 
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Press M to change the file mask.  Wild cards are supported, in fact 

the default is (*.*). 

If an attempt to display a disk with more than 60 files is made, you 

will be asked to refine the file mask to reduce the number of files 

displayed. 
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Load 

The Load option is used to load a previously saved screen.  It is 

designed to load screens saved by Mr. Paint.  However, you may be 

able to load *some* screens saved with other programs providing the 

file format is acceptable. 

You will be presented with a Load File dialog which prompts for the 

file to load.  Enter the name using the drive:filename.ext syntax 

(ie: D1:NONAME.ATA).  Once the name is entered, press TAB or press 

ENTER to advance to the OK and Cancel soft buttons.  Then select OK 

or Cancel as appropriate.  While loading a progress bar will be 

displayed. 

Once loading is complete, you will be returned to the editor screen 

with the loaded screen contents displayed: 

The load routine will look for an Atari clear character (}, hex 7D, 
decimal 125) in the first byte, and if found will enable the Add 

Clear preference, but NOT include it in the screen itself. 
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Save 

Guess what save does?  That’s right, this is where you save your 
ATASCII masterpieces to file.  Like Load, you will be presented 
with a Save File dialog which prompts for the filename to save to.  

The filename populated will be that of the default (NONAME.ATA) 

unless a filename has been previously entered at a filename prompt.  

Mr. Paint remembers and uses a filename until changed again.  

The dialog also contains a selection checkbox for Raw.  Checking 

this box will cause the screen to be saved in the Raw format.  Raw 

format saves the screen as a linear sequence of ATASCII characters 
without any newlines.  All 40 characters of all 24 lines are written 

to file consecutively, producing a 960 byte file.  The Trim Trailing 

and Add Clear preferences are ignored when saving in this format. 

With Raw unchecked, the screen will be saved in ATASCII format, 
which means there will be an Atari newline character (hex 9B, 

decimal 155) placed at the end of each line as they are written to 

the file from the top line to the bottom line. 

If the Trim Trailing preference is enabled, then each line will have 

the right side (end) trimmed of empty space before the Atari newline 

is added.  So, if there is a line where the last character is 25, 

the last 15 characters of the line will be omitted.  This is NOT 

applicable when saving in the Raw format. 

If the Add Clear preference is enabled, an Atari clear character 

(}, hex 7D, decimal 125) will be added as the first byte of the 
output file.  This is NOT applicable when saving in the Raw format. 

Use TAB or ENTER to move between dialog form elements.  Use SPACE or 

X to toggle the Raw checkbox when it is highlighted. 

Once the form is accepted, Mr. Paint will check to see if the file 

already exists.  If it does you will be prompted to confirm an 

overwrite. 

17



Once the Save File dialog form is accepted, the file will be loaded 

and a progress bar will be shown. 

New 

The New option allows you to clear the contents of the editor screen 

(buffer).  If you have made and edits to the screen and not saved 

it, you will be prompted to confirm.   

18



Print 

The Print option allows you to print the editor screen contents to a 

printer.   

There is a special caveat!  This is not a graphical dump to a 

graphic printer.  This requires a printer capable of producing 

ATASCII output such as the soft ATASCII printers in Atari800MacX 
and FujiNet!  Printing to any other printer will product garbage 

results.  The soft printers typically allow saving to PDF, which can 

in turn be printed to any modern printer from a modern OS.  There is 

one exception to this rule - printing an all ASCII screen, which 

should work on any printer. 

Upon selection a Print File dialog is presented.  Enter the printer 

device (ie: P1:) that you want to print to.  There is no restriction 

on the device name. 

Use TAB or ENTER to move between dialog form elements.  Then choose 

OK to start the print.  Like Load and Save, a progress bar will be 

displayed while printing. 
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Examples of printouts follow.   

A screen using ATASCII characters printed to the ATASCII printer 
in Atari800MacX is on the left. A screen using ASCII characters only 

printed to an emulated Epson FX80 is on the right: 
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Edit Menu 

The Edit menu holds two options. 

Keys accepted are: 

- LEFT and RIGHT, or UP and DOWN, will move between selectable 

options. 

- RETURN selects the currently highlighted item. 

- ESC exits the Edit menu. 

  

Each option is described on the following pages. 
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Background 

The Background option allows you to set the entire screen to a 

specific character.  You must know the ATASCII character code for 
the character to be set. 

A small popup will be presented in which you enter the three digit 

ATASCII code.  The ATASCII code of the character under the 
cursor will be populated by default. 

Press ENTER to accept, or ESC to cancel.  If you have previously 

altered the edit screen (buffer), you will be asked to confirm the 

operation because it will destroy existing editor contents. 
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Center Row 

The Column Row option allows you to center the contents of the 

current row (where the cursor is located).  Leading and trailing 

space is trimmed, and the remaining line content is centered.  Line 

content can contain spaces between the first and last characters 

without issue. 
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Column Fill 

The Column Fill option allows you to set the entire current column 

(where the cursor is located) to a specific character.  You must 

know the ATASCII character code for the character to be set. 

A small popup will be presented in which you enter the three digit 

ATASCII code.  The ATASCII code of the character under the 
cursor will be populated by default. 

Press ENTER to accept, or ESC to cancel.  No confirmation is asked.  

If the column contains characters, they will be overwritten with the 

new character. 
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Row Fill 

The Row Fill option allows you to set the entire current row (where 

the cursor is located) to a specific character.  You must know the 

ATASCII character code for the character to be set. 

A small popup will be presented in which you enter the three digit 

ATASCII code.  The ATASCII code of the character under the 
cursor will be populated by default. 

Press ENTER to accept, or ESC to cancel.  No confirmation is asked.  

If the row contains characters, they will be overwritten with the 

new character. 
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Preferences 

The Preferences option allows you to set several program wide 

options.  A dialog form is presented.  The primary navigation keys 

for the form are TAB (skip to next field) and ENTER (accept field).  

Each field has keys that assist with entry and selection.  The Nav 

bar on the bottom frame of the dialog will indicate which keys are 

active for each field as the field becomes active. 

The first field is the Work Drive field, which will be active when 

the dialog form is opened.  This sets the drive number Mr. Paint 

uses for the initial save or load after the program is loaded, and 

which drive will be read first when opening the Directory. 

The remaining options are checkboxes.  The SPACE or X key will 

toggle their values.   
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A brief description of each option follows: 

-

Key Click - Enables or disables a very subtle audible key click as 

each characters are entered in the editor. 

-

Add Clear - Enables or disables adding the Atari clear character 

() to the beginning of saved files that are not saved in the Raw 

format. 

-

Auto Advance - Enables or disables the cursor auto advance 

function.  When enabled the cursor will move 1 character to the 

right after each character keypress.  It will also cause DELETE to 

move 1 character to the left after each press. 

-

Trim Trailing - Enables or disables the trimming of space from the 

end of lines when not saving in Raw mode. 

And last on the dialog form are the Ok and Cancel soft buttons.  

Selecting Ok will cause Mr. Paint to remember these settings until 

the program is exited, or they are changed again - whichever comes 

first.  Selecting Cancel will cause Mr. Paint to forget the changes 

you have made.  In either case you are returned to the editor. 
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Help Menu 

The Help menu is where you can get quick hints on the program and 

its usage. 

Keys accepted are: 

- LEFT and RIGHT, or UP and DOWN, will move between selectable 

options. 

- RETURN selects the currently highlighted item. 

- ESC exits the Help menu. 

There are three options.  Each is discussed below. 

About 

The about option re-displays the Mr. Paint splash screen.  It 

contains version, build date, copyright, author, and license 

information. 
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Keys 

The Keys option displays a dialog of helpful key combinations.  

These are discussed in detail in the Editor / Keystrokes section of 

this user guide. 

This is also available from the editor by pressing the HELP button. 

Map 

The Map option displays a dialog showing which keys on the keyboard 

correspond to which Atari ATASCII control characters, both normal 
and inverse.  It can be used as a quick reference to find a 

character you have forgotten the mapping to. 
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Quit 

The Quit option exits Mr. Paint.  If the underlying DOS supports it, 

you will be returned to the DOS’s command interpreter or shell, 
whichever is applicable.   

If you attempt to Quit with a modified screen (buffer), you will be 

prompted to confirm to prevent the loss of your ATASCII work of 
art. 
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Example Screens 
1.This screen uses all ATASCII characters, both inverse and 

normal, saved in Raw mode.  On the top is the screen captured in 

the Mr. Paint editor.  On the bottom is the screen copied to the 

Atari screen from DOS. 
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2. This screen is a modified version of example 1.  It is set with a 

screen end marker, and saved with Trim Trailing enabled. 

On the left is the screen copied to the Atari screen from DOS as 

saved with the above configuration. 

On the right is the same screen copied to the Atari screen from DOS 

as saved with Add Clear enabled as well. 
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License 
Mr. Paint is released as freeware.  

Mr. Paint © 2025 by Wade Ripkowski is licensed under CC BY-NC-SA 4.0 




ATTRIBUTION-NONCOMMERCIAL-SHAREALIKE 4.0 

INTERNATIONAL 

You are free to: 

-

Share - copy and redistribute the material in any medium or format 

-

Adapt - remix, transform, and build upon the material 

-

The licensor cannot revoke these freedoms as long as you follow 

the license terms. 

Under the following terms: 

-

Attribution - You must give appropriate credit , provide a link to 

the license, and indicate if changes were made. You may do so in 

any reasonable manner, but not in any way that suggests the 

licensor endorses you or your use. 

-

NonCommercial - You may not use the material for commercial 

purposes. 

-

ShareAlike - If you remix, transform, or build upon the material, 

you must distribute your contributions under the same license as 

the original. 

-

No additional restrictions - You may not apply legal terms or 

technological measures that legally restrict others from doing 

anything the license permits. 

Notices: 

You do not have to comply with the license for elements of the 

material in the public domain or where your use is permitted by an 

applicable exception or limitation . 

No warranties are given. The license may not give you all of the 

permissions necessary for your intended use. For example, other 

rights such as publicity, privacy, or moral rights may limit how you 

use the material. 

License link: https://creativecommons.org/licenses/by-nc-sa/4.0
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